Chapter 1

Introduction to
AutoCAD Civil 3D 2016

Learning Objectives

After completing this chapter, you will be able to:

* Understand basic features of AutoCAD Civil 3D 2016

* Understand AutoCAD Civil 3D 2016 screen components

* Get Familiar with different workspaces in AutoCAD Civil 3D 2016
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INTRODUCTION TO AutoCAD Civil 3D 2016

AutoCAD Civil 3D is a powerful Building Information Modeling (BIM) tool that is used for
designing, analyzing, and documenting engineering projects such as land development,
transportation, and environmental projects.

This software includes various sets of tools for designing a civil engineering project along with
the tools from other Autodesk products such as AutoCAD and Map 3D. It also has interfacing
application such as Trimble Link™, Carlson Connect™, and Leica Exchange for transferring
and converting data set into Civil 3D environment. These tools can be accessed through toolbars
and Ribbon provided in the software interface. Civil 3D also supports the traditional commands
that exist in AutoCAD software to invoke various tools. These commands are executed using the
command prompt in the software.

AutoCAD Civil 3D 2016 provides a model-centric technology at the core that enables the
entire team in a project to coordinate and work on a single updated model. Data sharing is
conducted through various approaches ranging from Xrefs and data shortcuts to integrated data
management controls. These approaches help team members to work in parallel, connected
locally or remotely, on the latest updated model. As a result, a project can be managed well and
the budget can also be controlled.

BASIC FEATURES OF AutoCAD Civil 3D

AutoCAD Civil 3D features a range of design and analysis objects within its three-dimensional
dynamic engineering model. These Civil 3D objects include points, surfaces, parcels, alignments,
profiles, and gradings. All objects in this model have a hierarchical interaction mechanism with
each other. This mechanism ensures that modifications carried out in one object are truly reflected
in other objects that are connected to it.

A Civil 3D object is a drawing element that maintains a relationship with another Civil 3D
objects. For example, an alignment object is a combination of lines and curves in a horizontal
plane that collectively defines the location of a project component, such as the centerline of a
road. This alignment can be an independent object or it can be a parent object of other Civil
3D objects such as profiles and cross-sections. If you edit this alignment object it will result in
the change of other related Civil 3D objects.

Civil 3D has other objects such as points, surfaces, alignments, profiles, sites, parcels, gradings,
corridors, assemblies, and subassemblies. All these objects have a designated hierarchy that can
be viewed in an interface component called the TOOLSPACE palette.

AutoCAD Civil 3D also features various other object components such as tables, object labels,
and the analysis results that are derived from the model. These object components are associated
with the core model, and they can be dynamically updated so as to reflect any change made in
the core model.

Some of the various objects required to create a Civil 3D model are discussed next.
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Points

Points are the basic building blocks in AutoCAD Civil 3D. In Civil 3D, points are coordinate
geometry points and are also known as the COGO points. In a civil engineering project, points
are used to represent the existing ground locations and design elements. A Civil 3D point object
is different from the AutoCAD point object. An AutoCAD point merely displays the location of
an object. A Civil 3D point has a unique identification number and properties such as northing,
easting, elevation and description. These points can also have additional properties to control
their appearance such as point style, point label style, and layer.

Point Groups

The point groups allow you to group the COGO points together. The groups are created by
using the point objects that have similar characteristics. This helps you to control the overall
appearance of the points. Point group objects make it easy to change the point number, point
style, and other properties of a large number of points.

Surfaces

Surfaces are key objects in AutoCAD Civil 3D. They are the three-dimensional geometric
representation of a land terrain. In Civil 3D, you can calculate a composite volume surface that
represents the difference between two surface areas.

The surfaces are created using points, point files, DEM data, existing AutoCAD objects, contours,
breaklines, and boundaries. You can also import the information regarding the surfaces from
LandXML, TIN (Triangulated Irregular Network), and DEM (Digital Elevation Model) files.

In AutoCAD Civil 3D, you can perform various surface analyses to show different height ranges,
slopes, and watershed areas. This is done to ensure that there are no unwanted point in the design.

Alignments

The alignment objects in civil engineering projects represent the geometry of features like
the pipeline, road, canal, railway, or construction baselines in a horizontal plane. Creating
and defining the alignment is the first step in the design process of highway, railway, or other
engineering projects.

In AutoCAD Civil 3D, an alignment object can be created from a polyline or by using the
Alignment Layout Tools toolbar. The alignment objects can also be edited using the grips or
commands in the Alignment Layout Tools toolbar.

Profiles

The profiles (or long sections) are used to show surface levels along a selected horizontal
alignment using the specified surfaces. After creating a profile in Civil 3D, you can design the
vertical alignment directly on it by using standard alignment tools, grips, or editors.

Profile Views

The profile views are used to represent the graph lines which form the grid along which the
profile is plotted. One profile view object can be used to represent multiple profiles. Profile
view object also includes data bands. Data bands can be used to display additional information
about the profile view.
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Assemblies and Subassemblies

Assemblies constitute the primary structure of an AutoCAD Civil 3D corridor model. The
subassemblies are the building blocks for creating an assembly. The assembly objects are
composed of subassemblies. The assembly forms the primary structure of a corridor model.
The subassemblies can be carriage ways, curbs, and slopes that can be added to the assembly
baseline to create an assembly.

Corridors
A corridor represents a path, such as a road, railway, or canal. The horizontal and vertical
geometry of a corridor is defined by the alignment and the profile.

The corridor objects are created along one or more baselines (alignments). These are then created
by placing a 2D section (assembly) at incremental locations along the baselines and by creating
matching slopes that reach a surface model at each incremental location. The corridor models
can be edited on the basis of sections.

Parcels

The parcels represent any closed boundary that is spatially referenced to a geographical location.
However, the major use of parcel is to represent a tract of land which could be a lot in a subdivision.
Parcel can also be a water body or even a lot in a given site which is termed as site parcel.

Grading

In AutoCAD Civil 3D, the grading tools enable the engineers to grade a surface by applying
difterent grading criteria. On applying grading to a surface, you can analyze the grading and
balance the cut and fill volumes of a surface.

Sections

In AutoCAD Civil 3D, sections or cross-sections provide a view of the terrain that is cut at
an angle across a linear feature such as a proposed road. The sections are cut across the
horizontal alignments at specified station intervals. These sections can be plotted individually
for a specified station or as a group for a specified range of stations, depending on the purpose
of a plot. You can generate the section volumes from a design for earthworks and materials
using the Quantity Take Off tools.

Pipe Networks

You can use pipe networks to design the utility system such as the storm and wastewater system
which carry fluids under the effect of gravity. The pipe networks are created from design catalogs,
and can be edited in plan views. You can also display the pipe network parts in profile and section
views. Therefore, if a change is made to the pipe networks in plan view, the profile and section
views are dynamically updated.

Pressure Pipe Networks

In Civil 3D, the pressure pipe network consists of objects that are used to design a pipe network
that carries fluids under pressure, such as water supply network. In this category, various tools are
provided to design the network in plan and profile layout. Similar to pipe network, the pressure
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pipe network is created from the parts that are available in a parts list. This parts list is derived
from the AutoCAD catalog which is a master collection of various available parts.

Superelevation View

Superelevation or banking is defined as the transverse inclination to the road pavement surface
created to counter the centrifugal forces that are exerted on the vehicle while travelling along
a curved path. The superelevation view in Civil 3D is used to represent the superelevation. It is
also used to perform the superelevation calculations and edit the superelevation data.

Round-Tripping Data between Civil 3D 2016 and its Previous

Versions

In Civil 3D 2016, round-tripping of data has been extended to its previous versions upto 2013.
This feature enables a file created in Civil 3D 2016 to be opened in Civil 3D 2013, thus making
the current version of the Civil 3D backward compatible. For example, if you open the drawing
file in Civil 3D 2013 having an alignment and profile created in Civil 3D 2016, then the alignment
and profile will appear as regular editable objects and not as reference objects. However, due
to the enhancements made in editing functionality of some of Civil 3D objects (tools) in 2016
version, the objects created using the enhanced tools will appear as proxy objects and therefore
will not be editable in 2013 version. For example, when a drawing file created in Civil 3D 2016
that has a pressure network object table is opened in Civil 3D 2013, the pressure network object
table will be displayed as a proxy object and the table will not be updated even if any edits are
made to the referenced pressure network. Also, if this drawing file with the edits is saved in Civil
3D 2013 and then reopened in Civil 3D 2016, Civil 3D 2016 will automatically update the table.

STARTING AutoCAD Civil 3D 2016

You can start AutoCAD Civil 3D 2016 by double-clicking on its shortcut icon on the desktop
or from the taskbar. To start it from the taskbar, choose Start > All Programs > Autodesk >
Autodesk AutoCAD Civil 3D 2016 - English > Civil 3D 2016 Imperial (for windows 7) refer
to Figure 1-1; AutoCAD Civil 3D 2016 will start and a window will be displayed with the New
Tab chosen by default.

This tab contains two other tabs: Learn and Create. The Learn tab consists of three panes. The
left pane of this tab contains a list of video links under the head New Features. The mid pane
displays a list of videos under the head Getting Started Videos. These links and videos can
be used as additional learning resources. The right pane of the create tab contains the links
for security updates and online resources under the Security Updates and Online Resources
heads respectively.

The Create tab also has three panes which provide information on how to get started with Civil
3D. The list of recently opened documents and the notifications are under the heads Get Started,
Recent Documents, and Notifications respectively.
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Figure 1-1 Starting AutoCAD Civil 3D 2016 from the taskbar

AutoCAD Civil 3D 2016 USER INTERFACE

The Civil 3D interface consists of various components such as the drawing area, command window,
toolbars, Ribbon, model and layout tabs, Status Bar, TOOLSPACE palette, and PANORAMA
window, as shown in Figure 1-2. The title bar is displayed on the top of the screen and displays
the current drawing name.

The AutoCAD Civil 3D interface components are discussed next.

Drawing Area

The drawing area covers the major portion of the screen. Here, you can draw various objects
and use commands. To draw the objects, you need to define the coordinate points that can be
selected by using a pointing device. The position of the pointing device is represented on the
screen by the cursor. There is a coordinate system icon at the lower left corner of the drawing
area. The window also has standard Windows buttons such as close, minimize, scroll bar, and so on
at the top right corner. These buttons have the same functions as in any other standard window.
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Figure 1-2 AutoCAD Civil 3D 2016 interface components

Ribbon

The Ribbon interface in AutoCAD Civil 3D has a collection of tools that are grouped into various
tabs based on their functionality. This interface provides an alternative to the layered menus,
toolbars, and task panes which were used previously for displaying tools. The tools in the tabs are
further sub grouped and placed into various panels depending on their usage and functionality.
To invoke a command, choose the required tool from the Ribbon. Figure 1-3 shows the typical
Home tab of the AutoCAD Civil 3D Ribbon.

Home Insert  Annotate M An Manage
® |mport Survey Data Parcel - lignment - ntersections =

< Points ~ * T Feature Line ~ ks Profile = embly =
Tool .
oolspace

F B & surfaces - " Grading - orridar

Palettes = Create Ground Data + Create Design =

Figure 1-3 Partial view of the Ribbon showing the Home tab

When you start the Civil 3D session for the first time, by default the Ribbon is displayed
horizontally below the Quick Access Toolbar. The panels in the Ribbon have various tools
arranged in rows. Some of the tools have a small white down arrow displayed on their right. This
arrow indicates that there are other tools as well that have similar functions and are grouped
together in this drop-down. Click on the down arrow; a list of tools will be displayed. Note that
if you choose a tool from the drop-down, the corresponding command will be invoked and the
tool that you have chosen will be displayed in the panel. For example, to create a surface using
the Create Surface tool, click on the down arrow next to the Surfaces drop-down in the Create
Ground Data panel of the Home tab. Choose the Create Surface tool from the drop-down; the
Create Surface dialog box will be displayed. Next, specify the various options in this dialog box
to create the required surface.

In this book, the tool selection sequence is written as: choose the Create Surface tool from Home
> Create Ground Data > Surfaces drop-down.
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Some panels have a down arrow displayed on the right of their name. This indicates that
more tools are available. To access these tools, click on the down arrow to expand the
panel. You will notice that a push pin is available at the left of the panel. Click on the push |
pin to keep the panel in the expanded state. Also, some of the panels have an inclined
arrow at the lower right corner. When you click on an inclined arrow, a dialog box will be
displayed.You can define the setting of the corresponding panel in the dialog box.

You can reorder the panels in the tab. To do so, press and hold the left mouse button on the
panel to be moved and then drag it to the required position in the tab. To undock the Ribbon,
right-click on the blank space in the Ribbon; a shortcut menu is displayed. Choose the Undock
option from the shortcut menu. Civil 3D allows you to customize the display and the contents of
the tabs and panels in the Ribbon. To customize the Ribbon, right-click in the Ribbon; a shortcut
menu will be displayed. Hover the cursor over an option in the menu; a flyout will be displayed.
For example, if you hover the cursor over the Show Tabs option, a flyout will be displayed with
the list of names of tabs that are available in the Ribbon. In the flyout, by default, a check mark
is displayed beside those tab names that are available in ribbon. The check indicates that the
corresponding panel will be displayed in the Ribbon. If you clear the check, the corresponding
tab will get hidden in the Ribbon.

Application Menu
The Application Menu, shown in Figure 1-4, will be displayed when you choose the Application
button located on the top left corner of the Civil 3D window.

- Search Commands A
(53 E Create a new drawing
D New 4 [Emx Drawing
I~ Start a new drawing with a selected
b drawing template file,
E7 Open 3
Sheet Set
& Create a sheet set data file that
E Save manages drawing layouts, file paths,
and project data,
B Save As 3
= Export »
@ Publish 3
@ Frint 3
—. Suite
Workflow »
= H
Drrawing b
Utilities
Close 3
a
| Options | | Exit Autodesk AutoCAD Civil 30 2016

Figure 1-4 The Application Menu



Introduction to AutoCAD Civil 3D 2016 1-9

It contains some of the tools that are available in the Standard toolbar. You can search a command
using the search field in the Application Menu. To search a tool, enter the complete or partial
name of the command in the search field; the possible tool list will be displayed. If you click on
a tool from the list, the corresponding command will get activated.

By default, the Recent Documents button is chosen in the Application Menu. As a result,
the list of recently opened drawings will be displayed in the menu. If you have opened
multiple drawing files, choose the Open Documents button; the documents that are
opened will be listed in the Application Menu. To set the preferences of the file, choose =
the Options button available at the bottom right of the Application Menu. To exit Civil3D,
choose the Exit Autodesk AutoCAD Civil 3D 2016 button next to the Options button.

Command Window

The command window located at the bottom of the drawing area has the command prompt
where you can enter the commands. It also displays the subsequent prompt sequences and
messages, refer to Figure 1-2. You can change the size of the window by placing the cursor on the
top edge (double line bar known as the grab bar) and then dragging it. This way you can increase
its size to see the previous commands that you have used. By default, the command window
displays only three lines. You can also press the F2 key to display the AutoCAD Text window.

Drawing File Tabs

The Drawing File Tabs displayed above the drawing area, refer to Figure 1-2, shows drawing that
are currently opened. Using these drawing tabs, you can quickly switch between the drawings. The
order in which these tabs are displayed is based on the sequence in which the files are opened.

Status Bar

The Status Bar is displayed at the bottom of the screen, as shown in Figure 1-5. It contains
some useful information and buttons that will make it easier for you to change the status of
some AutoCAD functions. You can toggle between on and off states of most of these functions
by choosing buttons from this bar.

Customization

Clean Screen

Snap Mode ——

Isolate Objects

Hardware Acceleration- Off  ——
Annotation Moniter - off —
Workspace Switching
Annotation Scale —

Grid Mode

Model or Paper space

Hopening an AutoCAD 2007/LT 2007 format file.
Re el

r Autodesk licensed application.

MODEL| §if i v b & v\~

Automatically add scales to annotative

Ortho Mod
o Moce objects when annotation scale changes

Polar Tracking
Isometric Drafting - Off
Object Snap Tracking

‘Annotation Visibility: Show annotative objects

Object Saap Show / Hide Lineweight

Figure 1-5 The Status bar displayed in the Civil 3D workspace

Model

The Model button is chosen by default because you work in the model space to create drawings.
You will learn more about the model space in later chapters.
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Display drawing grids

The grid lines are used as reference lines to draw objects in AutoCAD. If the GRIDMODE button
is chosen, the display drawing grid will be on and the grid lines will be displayed on the screen.
The F7 function key can be used to turn the grid display on or off.

Snap Mode
You can choose this button to turn on the snap mode. In this mode, the cursor moves in fixed
increments. The F9 key acts as a toggle key to turn the snap off or on.

Ortho Mode

You can choose this button to draw lines at right angles only. You can use the F8 function key
to turn ortho mode on or off.

Polar Tracking

If you turn the polar tracking on, the movement of the cursor is restricted along a path based
on the angle set as the polar angle. Choose the Polar Tracking button to turn the polar tracking
on. You can also use the F10 function key to turn on this option. Note that turning the polar
tracking on, automatically turns off the ortho mode.

Isometric Drafting

In AutoCAD, you can activate the required working plane. To activate the required working
plane, choose the Isometric Drafting button from the Status Bar. On choosing this button, a
flyout is displayed with the isoplane Left, isoplane Top, and isoplane Right options. You can
choose the required option from this flyout to activate the respective work plane.

Object Snap Tracking

When you choose this button, the inferencing lines will be displayed. Inferencing lines are dashed
lines that are displayed automatically when you select a sketching tool and track a particular
keypoint on the screen. Choosing this button turns the object snap tracking on or oft. You can
also use the F11 function key to turn the object snap tracking on or off.

Object Snap

When the Object Snap button is chosen, you can use the running object snaps to snap on to
a point. You can also use the F3 function key to turn the object snap on or off. The status of
OSNAP (off or on) does not prevent you from using the immediate mode object snaps.

Show/Hide Lineweight
This button in the Status Bar allows you to toggle on or off the display of lineweights in the
drawing. If this button is not chosen, the display of lineweight will be turned off.

Show annotation objects
This button is used to control the visibility of the annotative objects that do not support the
current annotation scale in the drawing area.

Add Scales to annotative objects when the annotative scale changes
On choosing this button, the annotation scales that are set current will be added to all the
annotative objects present in the drawing.
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Annotation Monitor

The Annotation Monitor button helps you to identify and address the disassociated annotations
in the drawing. When this button is activated, you are automatically notified about the non
associative dimensions, leaders and associated model geometry.

Hardware Acceleration On
This button is used to set the performance of the software to an acceptable level.

Isolate Objects

This button is used to hide or isolate objects from the drawing area. On choosing this button, a
flyout will be displayed. Choose the required option from this flyout and then select the objects
to hide or isolate. To end isolation or display a hidden object, choose this button again and
choose the End Object Isolation option.

Clean Screen

The Clean Screen button is available at the lower right corner of the screen. When you choose
this button, it displays an expanded view of the drawing area by hiding all the toolbars except
the command window, Status Bar, and menu bar. Choose the Clean Screen button again to
restore the previous display rate.

Customization
The Customization button is available on the right corner of the Status Bar. Using this button,
you can add or remove tools in the Status Bar.

TOOLSPACE Palette

In AutoCAD Civil 3D, you can view the project data and its status at any time in the TOOLSPACE
palette. The data in the palette updates itself dynamically to show the status of the data within the
drawing. To display the TOOLSPACE palette in a drawing, choose the TOOLSPACE button from
the Palettes panel of the Home tab or type SHOWTS in the command line. There are four
tabs in the palette, Prospector, Settings, Survey, and Toolbox. These tabs are discussed next.

Prospector Tab

TE— The Prospector tab is used to manage project files.
- You can choose the Prospector tab in the
TOOLSPACE palette. The options in the Prospector tab,

. . . . =-[ civil3d_2016_c02_tutd1 ~
as shown in Figure 1-6, are used to view, edit, and manage -y General
drawings. You can also edit the object data for the Civil "g o o
3D objects that are present in the drawing. In this tab, all £ surtace
the objects in a drawing or project are arranged in a hi- :g ':':e‘g
erarchy. = Alignment
M Profile
m Profile View
The drop-down list displayed at the top of the Prospector - Superelevation View
. . . . . ﬂ Cant View
tab displays various options. The content displayed in the £4] samle Line
Prospector tab depends on the option selected from this 2 ecten
drop-down list. Select the Master View option from the O Mo Haui Line
By Mass Haul View &

drop-down list; all project and drawing items, including

TOOLSPACE "X
S

Active Drawing Settings View

drawing templates are displayed in a hierarchical Figure I1-6 The options displayed in
order in the Prospector tab. If more than one Civil 3D the Prospector tab
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drawing file are opened, then the name of the active drawing is highlighted. Select the Active
Drawing View option in the drop-down list; hierarchy of all the items in the active drawing is
displayed in the Prospector tab, refer to Figure 1-6. You can toggle the display of the Prospector
tab in the TOOLSPACE palette by choosing the Prospector button from the Palettes panel of
the Home tab.

Settings Tab
Choose the Settings tab from the TOOLSPACE palette; various options in this tab will
be displayed, as shown in Figure 1-7. You can also invoke this tab by choosing the Settings
button from the Palettes panel of the Home tab. You can use this tab to view, create, and
modify different styles for different object types in Civil 3D. This tab is also used to control the
settings for drawings and commands.

Survey Tab

Choose the Survey tab from the TOOLSPACE palette; various options in this tab will be
displayed. You can also invoke this tab by choosing the Survey button from the Palettes

panel of the Home tab. The Survey tab shows the survey data present in the AutoCAD Civil 3D

projects folder. This survey data can be accessed from multiple drawings. This tab displays a

collection of databases such as Survey Databases, Equipment Databases, Figure Prefix

Databases, and Linework Code Sets, as shown in Figure 1-8.

The survey databases consist of the records of survey points whereas the equipment database
records the standard deviations and other operational parameters of the equipment used for the
survey. The figure prefix databases record the conversion routines that are used while creating
site features from the survey points.

TOOLSPACE TOOLSPACE

Active Drawing Settings View 2
5[ civil3d_2016_c02_tut01 ~ B
ﬂﬁ\f{ General
# Point

@ Paint Cloud
@ Surface
aﬂ Parcel

@ Grading

% Survey Databases

F'Q Equipment Databases
é‘j Figure Prefix Databases
B I;_gfi Linework Code Sets

' Profile

M Profile View

E, Superelevation View
& Cant View

[1'7] Sample Line
i Section

é Section View
25 Mass Haul Line
Aqy Mass Haul View

Figure 1-7 The Settings tab chosen Figure 1-8 The Survey tab chosen in
in the TOOLSPACE palette the TOOLSPACE palette
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Toolbox Tab

Choose the Toolbox button from the Palettes panel of the Home tab; the options in this
tab will be displayed in the TOOLSPACE palette, as shown in Figure 1-9. This tab manages

reports for each type of object in Civil 3D. These reports provide you useful engineering

information regarding the objects in the drawing. The data available in these reports can be in

Land XML format with custom/predefined XSL style sheets or in a .NET format.

TOOLSPACE

ports Manager
Alignment
Corridor
Parcel
Pipes
Points
Profile
Surface

Breakline

- & Subscription Extension Manager

t- 54 Miscellaneous Utilities

Figure 1-9 The Toolbox tab chosen in the TOOLSPACE palette

The TOOLSPACE Item View

The Toolspace Item View is used to view the contents of a given node or subnode in a list. This
pane is displayed below the tree in the TOOLSPACE palette. For example, the Points node has
a set of points which are displayed in the Toolspace Item View, refer to Figure 1-6.

Shortcut Menu

AutoCAD Civil 3D provides you with shortcut menus that are an easy and convenient way of
invoking tools and the recently used commands. These shortcut menus are context-sensitive
which means that the commands present in them are dependent on the place or object for which
they are displayed. A shortcut menu is invoked by right-clicking and is displayed at the cursor
location. You can right-click anywhere in the drawing area to display the general shortcut menu.
The shortcut menus are also displayed when you right-click on one or more drawing objects
or on an individual item from the TOOLSPACE palette. Figure 1-10 shows a shortcut menu
displayed on right-clicking on the Points node in the Prospector tab.
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Figure 1-10 Shortcut menu displayed on right-clicking on the
Points node in the Prospector tab

Layout Tools

In AutoCAD Civil 3D, you can use various layout toolbars to create and edit the Civil 3D objects
such as Alignments, Grading, Points, Profiles, Pipes, Pressure Pipes, and Parcels. These toolbars
provide access to object-specific designs and edit commands. To invoke a toolbar, choose the
drop-down corresponding to the object. Next, choose the layout or creation method from the
options that will be displayed in the flyout. Figure 1-11 shows the Alignment Layout Tools -
<alignment name> toolbar invoked by choosing Alignment Creation Tools from Home >
Create Design > Alignment drop-down.

AI|gnmentLayUutTUoIs Alignment - (1) R X
Av KNI | /v v W O v | L2 5] AR & @

Select a command from the layout tools Spiral Type: Clothoid

Figure 1-11 The Alignment Layout Tools - <alignment name> toolbar

Autodesk 360

Autodesk 360 is a cloud computing platform introduced by Autodesk. This platform provides
a set of cloud services and products that can help you share, simulate, visualize, and design
your work. You can access to the Autodesk 360 services using your Autodesk ID. To login to
your Autodesk 360 account, choose the Sign In button in the InfoCenter toolbar; a drop-down
list will be displayed. Next, choose the Sign In to Autodesk 360 option from this list; the
Autodesk-Sign In dialog box will be displayed, as shown in Figure 1-12. Enter your credentials
in this dialog box and choose the Sign In button; Autodesk will validate your credentials and
then provide access to your account.

Q Tip. You can sign up for a free Autodesk ID by choosing the Need an Autodesk ID? link in
the Autodesk - Sign In dialog box.
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Meed an Autodesk ID? Forgot your password? v
Figure 1-12 The Autodesk - Sign In dialog box
PANORAMA Window

This window can be used to display the entities of the objects such as alignments and profiles
in a tabulated form. The PANORAMA window is a floating, dockable window that can be kept
open while working. This window includes several tables called vistas on different tabs. In the
PANORAMA window, the data displayed in black is editable and the data displayed in grey is
non-editable.

Civil 3D WORKSPACES

Workspaces are the set of toolbars, menus, and Ribbon that are grouped and organized together
to work in a custom and task-oriented environment. A workspace controls the layout of the Civil
3D user interface. When you use a specific workspace, you can view the Ribbon, toolbars, and
other applications that have been specified for the selected workspace. To invoke the applications
and tools that are specified in other workspaces, enter the commands in the command line.

You can select workspaces at the beginning when you start the Civil 3D application or anytime
during the drawing session. When you start AutoCAD Civil 3D, you are prompted to select a
specific workspace and then continue. Once you are done, you can switch to other workspace
settings at any time by choosing the Workspace Switching button that is located in the Status
Bar. On doing so, a flyout will be displayed, as shown in Figure 1-13.

Civil 3D

Drafting & Annotation
30 Maodeling
Planning and Analysis

Save Current As...

Workspace Settings...

Custemize...

Figure 1-13 The flyout displaying various
options for choosing a workspace
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Choose an option from this flyout for specifying different workspace settings in the current
drawing environments. After you choose the required option, the drawing interface will change
according to the setting of the workspace you have chosen.

In AutoCAD Civil 3D, there are four default workspaces such as Civil 3D, Planning and
Analysis, 2D Drafting & Annotation, and 3D Modeling. These default workspaces are designed
considering the tools that a user might use for that kind of project. You can also create your
own customized workspace and save it using the Save Current As tool from the flyout, refer to
Figure 1-13.

The default workspaces available in AutoCAD Civil 3D are discussed next.

Civil 3D
The Civil 3D workspace includes all the necessary tools and applications that required for
designing a civil engineering project such as the road, railway, or a pipe network designing project.

2D Drafting & Annotation

This workspace is used for the purpose of documentation of a project. The Annotation tab is
included in the Ribbon in this workspace. All the tools related to annotation are available in this
tab so that you can annotate easily as per your requirement.

3D Modeling

This workspace contains all the tools and applications that are available in the AutoCAD and
can be useful in AutoCAD Civil 3D.

Planning and Analysis
This workspace contains all the tools and features that are available in AutoCAD Map 3D and
can be used directly in AutoCAD Civil 3D.

GETTING STARTED WITH AutoCAD Civil 3D

Before you create a new project or start working on the existing project, you should be familiar
with various tools and concepts that can be applied to create the initial setup of the project. The
basic setup tools like drawing templates and setting units are discussed next.

Drawing Templates
Drawing templates are very useful tools for AutoCAD Civil 3D users. These tools help in
maintaining consistency throughout the drawings in the project.

To use a template in a drawing, choose the Prospector tab of the TOOLSPACE palette and then
select the Master View option from the drop-down list at the top. Now, expand the Drawing
Templates node and right-click on a template; a shortcut menu will be displayed, as shown in
Figure 1-14. To create a new drawing file, choose the Create New Drawing option from the
shortcut menu displayed; a new drawing file will be created using the settings of the drawing
template file that you had selected.
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Open
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Figure 1-14 Choosing a drawing template from the Drawing
Templates node of the Prospector tab

You can also open the existing drawing template in AutoCAD Civil 3D. To do so, choose the
Open option from the shortcut menu; the template will open in the drawing area.

An AutoCAD Civil 3D drawing template file contains information of the standard AutoCAD
settings such as layers, text styles, dimension styles, and so on. It also contains AutoCAD objects
such as lines and texts. The drawing template files also carry AutoCAD Civil 3D drawing
information that is listed in the Settings and Prospector tabs of the TOOLSPACE palette.

Drawing Settings

Drawing settings allow the user to review or modify settings specified for a drawing. To
edit the current drawing settings, right-click on the drawing name that is displayed in the
Settings tab of the TOOLSPACE palette; a shortcut menu will be displayed. Choose the Edit
Drawing Settings option from this shortcut menu, as shown in Figure 1-15; the Drawing
Settings - <drawing name> dialog box will be displayed, refer to Figure 1-16. This dialog box
contains five tabs that are discussed next.
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TOOLSPACE

Active Drawing Settings View

SN civilzd 2016 02 _#ut01
W General L3 Edit Drawing Settings...
m& Point Edit Label Style Defaults...
& Point Clou Edit LandXML Settings...
@ Surface Table Tag Numbering...

: %ﬂ Parcel o

L Peadina

Refresh

Figure 1-15 Choosing the Edit Drawing Settings option

A Drawing Settings - civil

Units and Zone ' ransformation I|Dbject Layers IlAbbreviations I|.Arnbier1t Settings I

Drawing units:
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Angular units:

[ 5cale objects inserted from other drawings Custom scale:

[Degrees

v] [ 5et AutoCAD variables to match &0

Zone

Categories:

Available coordinate systems:

o Datum, Mo Projection

Selected coordinate system code:

Description:

Mo Datum, Mo Projection
Projection:

Unknown projection

Datum:
Unknown Datum

Mo Datum, Mo Projection

Figure 1-16 The Drawing Settings dialog box

Units and Zone Tab

This tab is used to set linear and angular units, intended plot scale, and coordinate zone for

the current drawing.

Transformation Tab

This tab is primarily used to specify the parameters for the projection and coordinate system

of the drawing.
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Object Layers Tab

This tab provides a table in which the objects can be directly assigned a layer. To change the
layer of an object, click in the field of the Layer column corresponding to that object; the Layer
Selection dialog box will be displayed. In this dialog box, select the layer name that you want
to assign to the selected object and choose the OK button; the dialog box will be closed and the
selected layer name will be assigned to the object.

The layer of an object controls various properties like color, linetype, and lineweight of an object
to which it is assigned. As a result, the object to which a layer is assigned can have maximum
flexibility in its display.

Abbreviations Tab
In this tab, you can set the abbreviations used in object labels, especially for alignment and
profile geometry points.

Ambient Settings Tab

This tab provides global default settings such as precision, unit, and rounding of the numeric
values, visibility of tooltips, and so on. You can expand various properties and make the required
settings in the Value column of this tab. The ambient settings made in the Ambient tab are used
throughout the drawing, unless they are overridden at the feature or command level.

After configuring the settings in the Drawing Settings dialog box, you need to examine the
default styles for each feature and its labels, the feature name format, and other settings that
you may want to modify. To do so, go through Point, Surface, and other features in the Settings
tab and right-click on each feature. Next, choose the Edit Feature Settings option from the
shortcut menu to invoke the Edit Feature Settings dialog box. You can examine various settings
of the selected feature by using the options in this dialog box.

Self-Evaluation Test

Answer the following questions and then compare them to those given at the end of this
chapter:

1. The horizontal and vertical geometry of a corridor is defined by its and profile.
2. The palette is used to view the project data and its status at any time.
3. You can use the tab in the TOOLSPACE palette to view, create, and modify

different styles for different object types in Civil 3D.

4. Selecting the Active Drawing View option from the drop-down list in the Prospector tab
will display only the items in the drawing.

5. You can switch between the workspaces by choosing the button in the Status Bar.

6. In Civil 3D, each defined point has a unique number. (1/F)
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7. The Planning and Analysis workspace displays all the tools and toolbars that are available
in AutoCAD Civil 3D. (T/F)

8. You can invoke the Survey tab by choosing the Survey button from the Palettes panel of
the Home tab. (T/F)

9. The annotation scale controls the size and display of the annotative objects in the model
space. (T/F)

10. The SHOWTS command is used to display the TOOLSPACE palette. (T/F)
Review Questions
Answer the following questions:

1. In AutoCAD Civil 3D, the tool enables the engineers to grade a surface by
applying criteria such as slope to a surface or grade to a distance.

2. The tab in the TOOLSPACE palette manages reports for each type of object in
Civil 3D.
3. In AutoCAD Civil 3D, the workspace is used for the purpose of drafting and

annotating features.

4. In AutoCAD Civil 3D, provides you with a view of the terrain that is cut at an
angle across a linear feature.

5. The Transformation tab in the Drawing Settings dialog box is used to transform the
coordinate system to local specifications. (1/F)

Answers to Self-Evaluation Test
1. alignment, 2. TOOLSPACE, 3. Settings, 4. active, 5. Workspace Switching, 6. T, 7. F, 8. T,
9.7,10. T



